
Chapter 2

Exploring the 
Navigation Tools in

Navisworks

Learning Objectives
After completing this chapter, you will be able to:
• Use Head-Up Display
• Set view orientations
• Use ViewCube
• Use navigation tools
• Use camera
• Use reference views
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INTRODUCTION
In Navisworks, you can explore an integrated project model using navigation tools. These tools 
provide a real-time navigation experience in a project. Using these navigation tools, you will be 
able to move around and explore the model in the Scene View. In this chapter, you will learn 
how to use various navigation tools and features in Navisworks.

USING THE Head-Up Display FEATURE
The Head-Up Display (HUD) feature in Navisworks helps in displaying information about the 
camera location and model orientation in 3D workspace. It consists of three display elements: 
XYZ triad, position readout, and grid position. You can display the XYZ triad by selecting the 
XYZ Axes option from the HUD drop-down list in the Navigation Aids panel of the View tab. 
On selecting this option, the information about the orientation of the model will be displayed, 
as shown in Figure 2-1. 

Figure 2-1  Displaying the camera location, position, and grid location using the Head-Up Display

Select the Position Readout option from the HUD drop-down list to view the absolute camera 
position, x refer to Figure 2-1. Select the Grid Location option to view the grid and the location 
of the camera relative to the grid system currently used in the model.

SETTING VIEW ORIENTATIONS
In a project, you can set the view orientations by using various options. Although, Navisworks uses 
the cartesian coordinate system (X, Y, Z), the pointing direction of these axes is not fixed. By default, 
the Z axis points upward and the Y axis points toward north. However, you can change the up and 
north directions as per your requirement. To change the up direction, right-click in the Scene 
View; a shortcut menu will be displayed. Next, choose Viewpoint > Set Viewpoint Up > Set Up 
from the shortcut menu, refer to Figure 2-2. 

For example, to set the view orientation of X axis upward, choose the Set Up + X option from 
the shortcut menu, as shown in Figure 2-2. On doing so, you will notice that the XYZ axis triad 
in the Scene View displays the X axis pointing upward. Also, the view of the model is changed 
accordingly. For example, if you are using the Orbit tool and you have selected the Set Up+ Y 
option from the shortcut menu, the axis of rotation will be Y axis.
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 Figure 2-2  The options to change the Up vectors

You can also change the overall orientation of a view. To do so, choose the File Options  option 
from the Project panel in the Home tab; the File Options dialog box will be displayed. Next, 
choose the Orientation tab in the dialog box; the options in this tab will be displayed, as shown 
in Figure 2-3. The options in the Up area are used to change the up direction for the view. 
For example, to orient the view with Z axis in the upward direction, specify 1 in the Z edit box 
and 0 in the X and Y edit boxes in the Up area. Similarly, in the North area, you can change 
the north direction for the view. For example, to orient the view with Y axis in north direction, 
specify 1 in the Y edit box and 0 in both the X and Z edit boxes in the North area. On doing 
so, the view will be oriented with Z axis upward and Y axis in north. You can notice the changes 
will be reflected in the ViewCube.

Figure 2-3  The options displayed under the Orientation tab
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THE VIEWCUBE
Navisworks provides you with a navigation control called the

Figure 2-4  The ViewCube  

 
ViewCube that can be used to set the viewpoint of the model. 
You can also use the ViewCube to visually assess the current 
orientation of the model. The ViewCube comprises a cube, a 
compass ring at the base with various directions marked on it, 
and a home icon that helps to set the default view, as shown in 
Figure 2-4. By default, it is always displayed at the top right 
corner in the Scene View. If it is not visible, choose the ViewCube 
button from the Navigation Aids panel in the View tab; the 
ViewCube will be displayed in the Scene View. Using ViewCube, 
you can rotate the model around a pivot point. To do so, place 
the cursor on the ViewCube, press and hold the left mouse 
button, and then drag the cursor in the required direction. 
Alternatively, click on any face of the ViewCube to get the corresponding view of the model. 
The compass below the ViewCube indicates the north direction of the model. To rotate the 
model using compass, place the cursor on the compass; it will be highlighted. Press and hold 
the left mouse button and drag the cursor in the required direction. Alternatively, if you want 
to display any particular view of the model, such as the east view, click on the key letter E on the 
compass; the model will rotate in that direction. 

You can configure various settings of the ViewCube such as its opacity level, size, display of 
ViewCube, and the compass. To do so, invoke the Options Editor dialog box by choosing the 
Options button from the Application Menu. In the left pane of the dialog box, expand the 
Interface node and then select the ViewCube option displayed under this node; several options 
will be displayed in the right pane of the Options Editor dialog box, as shown in Figure 2-5.

Figure 2-5  The options displayed on selecting the ViewCube option



Exploring the Navigation Tools in Navisworks			         	                           2-5

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

You can toggle the display of the ViewCube by selecting or clearing the Show the ViewCube check 
box. Select the option from the Size drop-down list to configure the size of the ViewCube. By 
default, the Automatic option is selected in the Size drop-down list. To control the opacity level 
when the ViewCube is inactive, select the required value from the Inactive opacity drop-down 
list. Select the Keep scene upright check box to produce inverted orientations while dragging 
the ViewCube. In the When dragging on the ViewCube area, select the Snap to the closest view 
check box to snap the ViewCube snaps to one of the fixed views. Select the Fit-to-view on change 
check box in the When clicking on the ViewCube area to zoom in and out the Scene View while 
rotating the ViewCube. Select the Use animated transitions when switching views check box 
to display animated transitions. Select the Show the compass below the ViewCube check box 
to display the compass below the ViewCube.

In Navisworks, you can save a particular view of the model as the Home view. You can 
switch to this view by choosing the Home button in the ViewCube, refer to Figure 2-4. 
Alternatively,  right-click on the ViewCube; a shortcut menu will be displayed, as shown in 
Figure 2-6. Now, choose the Set Current View as Home option from the menu; the current 
view will be saved as home view. You can also switch between the perspective and orthographic 
view projection modes of the model. To do so, choose the Perspective or Orthographic option 
from the shortcut menu, refer to Figure 2-6. You can also access the ViewCube Options page 
and the Home view using this shortcut menu.

Figure 2-6  The shortcut menu displayed on right-clicking on ViewCube

THE NAVIGATION BAR
The Navigation Bar contains various tools such as Pan, Orbit, Zoom, Look, Walk, and Fly, refer 
to Figure 2-7. These navigation tools make it much comfortable and easier to navigate in the 
model. The Navigation Bar can be docked at the desired location in the Scene View. Also, the 
tools in Navigation Bar can be customized as per the requirement.

Figure 2-7  The Navigation Bar
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By default, the Navigation Bar is displayed at the right corner of the Scene View. If it is not 
displayed, then choose the Navigation Bar button from the Navigation Aids panel in the View 
tab; the Navigation Bar will be displayed in the Scene View. If you want to hide this bar, click 
on the same button again. By default, the docking position of the Navigation Bar is linked with 
the ViewCube. To unlink them, click on the Customize arrow in the Navigation Bar; a shortcut 
menu will be displayed, as shown in Figure 2-8. Choose the Docking Positions option from 
the shortcut menu; a cascading menu will be displayed. Choose the Link To ViewCube option 
from the cascading menu; the ViewCube will be unlinked with the Navigation Bar. Now, you 
can move the Navigation Bar at any desired location in the Scene View without affecting the 
location of the ViewCube.

 Figure 2-8  The shortcut menu displayed

You can also control the display of navigation tools in the Navigation Bar.  To do so, choose the 
navigation tools that you want to display in the Navigation Bar from the shortcut menu, refer 
to Figure 2-8. In the next section, you will learn about various tools in the Navigation Bar.

Pan Tool 
The Pan tool is used to move the model in the Scene View. During panning, the 
model moves along the direction of movement of the mouse. For example, if you drag 

the cursor in the upward direction, the model will move up; and if you drag the cursor in the 
downward direction, the model will move down. When you invoke this tool, a four sided arrow 
will be displayed in the Scene View. You can access this tool from the Ribbon as well. To do so, 
choose the Pan tool from the Navigate panel in the Viewpoint tab. You can also use the middle 
mouse button for panning while using the other tools such as Orbit and Look. 
 

Zoom Tools
The Zoom tools are used to increase or decrease the view size of a model. You can increase 
or decrease the view size of any particular item or point in a model. To do so, place the 
zoom cursor on that particular point; a pivot point will be displayed. The pivot point can 

be changed by changing the location of the cursor. When you click on the Zoom drop-down in 
the Navigation Bar; a list of tools will be displayed. You can access these tools from the Ribbon 
as well. To do so, click on the Zoom drop-down in the Navigate panel of the Viewpoint tab; a 
list of tools will be displayed, as shown in Figure 2-9. The tools in the Zoom drop-down are 
discussed next.
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The Zoom Window tool is used to zoom the specified area. To zoom

Figure 2-9  The Zoom 
drop-down

 
an area using this tool, choose this tool and then draw a window 
around the area to be enlarged; the area within the rectangle window 
will be enlarged. The Zoom tool is used to zoom the view by clicking 
or dragging the cursor. When you choose this tool; a magnifying-glass 
shaped cursor is displayed. Press and hold the left mouse button and 
drag the cursor in upward or downward direction to zoom the selected 
area. Choose the Zoom Selected tool from the drop-down to zoom the 
selected object or group of selected objects to get an enlarged view of 
the respective region. If no object is selected in the model, then the 
Zoom Selected tool will work as the Zoom All tool and will zoom the 
model to the maximum possible magnification.

Orbit Tools
The Orbit tools allow you to visually maneuver around the 3D 

Figure 2-10  The Orbit 
tool drop-down

objects to obtain different views. While orbiting, the camera 
location changes whereas the view remains fixed. To orbit 

around an object, click on the Orbit drop-down in the Navigation bar; 
a list of tools will be displayed. You can use the desired tool from the 
list. You can access these tools from the Ribbon as well. To do so, click 
on the Orbit drop-down in the Navigate panel of the Viewpoint tab; 
a list of tools will be displayed, as shown in Figure 2-10. The tools in 
the Orbit drop-down are discussed next.

The Orbit tool is used to move the camera around the pivot point of the model. Choose the 
Free Orbit tool to rotate the model freely around the central point about any direction. Choose 
the Constrained Orbit tool to rotate the model around the central point. On choosing this tool, 
the model will rotate in the left and right directions but its upward and downward movement 
will be constrained. On invoking this tool, the model will rotate around a fixed axis.

You can also use the Pan, Zoom, and Orbit tools together. For example, if you are rotating a 
model by using the Orbit tool and you need to zoom in/out for a better view, you can roll the 
middle mouse button forward/backward. 

Look Tools
The Look tools are used to adjust the view of a model. To use 

Figure 2-11  The Look 
drop-down

these tools, click on the Look drop-down in the Navigation Bar; 
a list of tools will be displayed. You can access these tools from 

the Ribbon as well. To do so, click on the Look drop-down in the 
Navigate panel of the Viewpoint tab; a list of tools will be displayed, 
as shown in Figure 2-11. The tools in the Look drop-down are discussed 
next.

Choose the Look Around tool to look around the model from the 
current position. In this process, you can look around the scene without 
changing your location. Choose the Look At tool to look at a particular point or object in the 
model. When you choose this tool, the shape of the cursor is changed in the Scene View. Click 



2-8 				                   	          Exploring Autodesk Navisworks 2021
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

on the specific object to analyze it. On doing so, the view will be adjusted. Note that in this case, 
only the camera position will be adjusted not the zoom factor. Choose the Focus tool to look at 
a particular point in the scene without changing the position of the camera. When you choose 
this tool, a cursor will be displayed in the Scene View. Place the cursor on the object you need 
to look at and click; the view will be adjusted according to the selected object.  

Walk and Fly Tools
The Walk and Fly tools are used to walk/fly around the model to have a real-time experience 
during navigation. The Walk tool is used to walk through a model. Invoke the Walk tool from 
the Navigation Bar; a feet cursor will be displayed on the screen. You can also invoke this tool 
from the Walk drop-down in the Navigate panel of the Viewpoint tab. To start navigating in the 
model, press and hold the left mouse button, and drag in the desired direction. Move the mouse 
forward to go forward. Similarly, to take left and right turns, move the mouse accordingly. Instead 
of using mouse, you can also use the arrow keys (left, right, up, and down) on the keyboard to 
navigate inside the model. The Fly tool is used to take a birds-eye view of a model or project. 
This tool is used for large sites so that you can easily navigate around the outside area of your 
model. When you invoke the Fly tool, an aeroplane cursor will be displayed in the Scene View. 
You can also invoke this tool from the Walk drop-down in the Navigate panel of the Viewpoint 
tab. To fly around the model, invoke the Fly tool from the Walk drop-down in the Navigation 
Bar. Next, press and hold the left mouse button and click to fly straight. To change the elevation, 
move up and down. To zoom in and out, use the up and down arrow keys, and to revolve the 
camera, use the left and right arrow keys.

There are some additional options which will make the navigation

Figure 2-12  The Realism 
drop-down list

 
easier and will give you a real experience. These options will become  
available in the Walk drop-down in the Navigation Bar after invoking 
the Walk tool. You can also invoke these options from the Realism 
drop-down list in the Navigate panel of the Viewpoint tab, as shown 
in Figure 2-12. These options are discussed next.

The Collision option is used to turn on collision detection. Turning 
this option on will prevent you from passing through the doors and 
columns while navigating. The Gravity option is used to follow the 
surface while walking and will prevent you from falling. This option 
is used with Collision. You can use Collision without Gravity, but 
Gravity cannot be used without Collision. This option works only with the Walk tool, and not 
with the Fly tool. The Crouch option is used to bend under the objects that are too low to walk 
under such as table. This option works only when Collision is activated.

In Navisworks, the Third Person option allows you to navigate the scene or model from the 
third person’s point of view. You can consider yourself as the third person and this third person 
is known as Avatar, refer to Figure 2-13. When you select the Third Person option from the 
Walk drop-down in the Navigation Bar; an avatar will be displayed in the Scene View. You can 
also display the avatar by selecting the Third Person option from the Realism drop-down in 
the Navigate panel of the Viewpoint tab.
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You can use the Collision, Gravity and Crouch options while working with the Third Person 
option. Using these options during the navigating, you can easily visualize how you will interact 
with the proposed model and can view the things inside the model in detail. There are several 
predefined avatars available in Navisworks and you can also create them.
 

 Figure 2-13  The third person view during the navigation in the model

Customizing Navigation Parameters
In Navisworks, you are provided with the options which help you for controlling the walk speed 
during navigation. You can change the overall walk speed for navigation by using the Edit 
Viewpoint dialog box. To invoke this dialog box, choose the Edit Current Viewpoint
button from the Save, Load & Playback panel in the Viewpoint tab; the Edit Viewpoint 
- Current View dialog box will be displayed, as shown in Figure 2-14. 

You can change the linear speed by specifying the value in the Linear Speed edit box in the 
Motion area of this dialog box. To set the angular speed, specify the value in the Angular Speed 
edit box in the Motion area of the dialog box. You can also change the linear speed from the 
Navigate panel in the Viewpoint tab. For specifying speed, expand the Navigate panel; the 
options for setting speed will be displayed. Now you can specify values in the Linear Speed and 
Angular Speed edit boxes.

You can also customize various options to change the behavior of the Walk tool using the Options 
Editor dialog box. You can invoke this dialog box from the Application Menu. Next, expand 
the Interface node available in the left pane of the dialog box; several options will be displayed 
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under this node. Select Navigation Bar from the left pane; various options for the Orbit and 
Walk tools will be displayed in the right pane of the dialog box, as shown in Figure 2-15.

Figure 2-15  The Navigation Bar options in 
the Options Editor dialog box

Figure 2-14  The Edit Viewpoint- 
Current View dialog box

Select the Use classic Walk check box in the Walk Tool area to switch to the classic Navisworks 
walk mode. Select the Constrain Walk angle check box to keep the camera vertical while 
navigating. Select the Use viewpoint Linear Speed check box to apply the viewpoint linear speed 
setting to the Walk tool. You can set the walking speed either by adjusting the Walk Speed slider 
or by entering the desired value in the corresponding edit box. This value ranges from 0.1 to 10.

Customizing Avatar Settings
The avatar settings such as avatar selection, dimensions, and positioning can be customized by 
using the options in the Options Editor dialog box. To do so, expand the Interface node in the 
left pane of the Options Editor dialog box; various options will be displayed under this node.
Select the Viewpoint Defaults option; several options will be displayed in the right pane of the 
dialog box. Choose the Settings button in the Collision area of the dialog box; the  Default 
Collision dialog box will be displayed, as shown in Figure 2-16. In this dialog box, select the 
Enable check box in the Third Person area; the options related to avatar position will be enabled. 
Select the desired option from the Avatar drop-down list and choose the OK button. You can 
also change the height of the avatar by specifying the value in the Height edit box in the Viewer
area. Similarly, in the Viewer area, you can change the size of the avatar by specifying a value in 
the Radius edit box. You can change the location of the camera with respect to the top of the 
avatar by specifying a value in the Eye Offset edit box, refer to Figure 2-16.
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 Figure 2-16  The Default Collision dialog box

You can also change the avatar for the current view by using the Edit Viewpoint - Current View 
dialog box. To do so, choose the Edit Current Viewpoint button from the Save, Load & Playback 
panel in the Viewpoint tab; the Edit Viewpoint - Current View dialog box will be displayed, as 
shown in Figure 2-17. Choose the Settings button in the Collision area; the Collision dialog 
box will be displayed, refer to Figure 2-16. You can now select a new avatar from the Avatar 
drop-down list. Next, choose the OK button to return to the Edit Viewpoint - Current View 
dialog box, and then choose the OK button to close the dialog box. The selected avatar will be 
displayed in the Scene View.

Figure 2-17  The Edit Viewpoint - Current View dialog box
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SteeringWheels
The SteeringWheels are tracking menus that 

Figure 2-18  The SteeringWheels drop-down

comprise multiple navigation tools in a single 
interface. These navigation tools are Pan, Zoom, 
Walk, Look, Orbit, Rewind, and Up/Down. A 
Steering Wheel is divided into different sections 
known as wedges. Each wedge contains a unique 
navigation tool. When you click on the 
SteeringWheels drop-down in the Navigation 
Bar; a list of tools will be displayed. You can 
access these tools from the ribbon as well. To do 
so, click on the SteeringWheels drop-down in 
the Navigate panel of the Viewpoint tab; a list 
of tools will be displayed, as shown in Figure 2-18. 
Select the wheel that you want to display. While 
using the SteeringWheels, you can activate a 
navigation tool available in it by pressing and 
holding the left mouse button over the 
corresponding wedge. Next, drag the tool over 
the drawing area, you can use the selected navigation tool for reorienting your view. To exit the 
selected navigation tool, release the left mouse button. The SteeringWheels are categorized into 
two types and they are discussed next.

2D SteeringWheel
The 2D Wheel SteeringWheel tool is used to work in the 2D view. Figure 2-19 shows a 2D Wheel. 
The 2D navigation wheel has three navigation tools: Zoom, Pan, and Rewind. The Zoom tool 
is a common navigation tool used for enlarging or reducing the viewing scale of the model. 
You can use the Pan tool for traversing across the model view. The Rewind tool can be used to 
display the views of the previous zooming states which are saved temporarily. 

Figure 2-19  The 2D Wheel

3D SteeringWheels
The 3D SteeringWheels navigation tools help you navigate through 3D views. Based on the size 
and appearance, the 3D SteeringWheels tools are categorized into two groups: Mini Steering 
Wheels and Big SteeringWheels. The Mini SteeringWheels are further classified into three types: 
Mini View Object Wheel, Mini Tour Building Wheel, and Mini Full Navigation Wheel, as shown 
in Figure 2-20. The Mini View Object Wheel has four distinct navigation tools, Pan, Zoom, 
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Rewind, and Orbit. Similarly, the Mini Tour Building Wheel comprises four unique navigation 
tools: Up/Down, Look, Walk, and Rewind. The Mini Full Navigation Wheel comprises eight 
wedges with each wedge representing a unique navigation function. The Mini Full Navigation 
Wheel combines all the functions of the Mini View Object Wheel and Mini Tour Building Wheel.

Figure 2-20  Different types of Mini SteeringWheels for 3D Views

The Big SteeringWheels contain same types of navigation tools as of  the Mini SteeringWheels, 
it is clear from Figure 2-21. However, the appearance of these tools on screen is very different 
from the Mini SteeringWheels.

                   Figure 2-21  The big SteeringWheels

When you put the cursor over any of the navigation tools, the tooltips and messages are displayed, 
as shown in Figure 2-22. These tooltips give information about the tool on which the cursor is 
placed.

Figure 2-22  The tooltip displayed on placing the cursor on the Orbit tool 
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CAMERA
In Navisworks, you can specify various camera options such as camera projection, position 
and orientation during navigation. There are two types of cameras available in Navisworks: 
perspective and orthographic. In 3D workspace, you can use both the perspective and the 
orthographic cameras, but in 2D workspace, only orthographic camera can be used. To use any 
of the two cameras, select an option from the Perspective drop-down list in the Camera panel 
of the Viewpoint tab; the view will be adjusted according to the selected mode. The field of 
view is the area of scene that can be viewed through a camera. You can adjust the field of view 
by specifying a value in the F.O.V edit box in the Camera panel of the Viewpoint tab, as shown 
in Figure 2-23. You can also use the F.O.V slider to adjust the viewing angle.

Note
When you move the F.O.V slider to the right, a wider field of the view will be displayed and when 
you move it to the left, a narrower field of the view will be displayed.

Figure 2-23  Various options in the Camera panel

The position of camera can be adjusted. To do so, slide the Camera panel in the Viewpoint 
tab. Next, specify the values in the Position edit boxes, refer to Figure 2-23. To change the focal 
point of the Camera, specify the values in the Look At edit boxes, refer to Figure 2-23. In the 
Camera panel, you can also adjust the rotation of the camera toward left or right by specifying 
the values in the Roll edit box. The Roll option is used to rotate the camera toward left or right. 
To rotate the Camera up or down, choose the Show Tilt Bar button in the Camera panel in 
the Viewpoint tab; the Tilt Bar will be displayed in the window. Drag the Tilt bar slider up or 
down to roll the camera.

You can align a camera to one of the axes which will change according to the camera’s position 
and orientation in the Scene View. To do so, click on the Align Camera option; a drop-down 
list will be displayed. For example, if you select Align X from the list; camera position will align 
along the X axis and the model position and orientation will change accordingly.
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REFERENCE VIEWS
Reference views are used to acquire an overall view of your position in the whole scene. It also 
helps you to quickly move the camera to a different location in a model. There are two types of 
reference views which can be used to view the model: Section View and Plan View. To access 
these options, chose the Reference Views option in the Navigation Aids panel of the View 
tab; a drop-down list will be displayed. Select the Section View option from the drop-down list 
to display the front view of the model; the view will be displayed in the Section View dockable 
window, as shown in Figure 2-24. You can also select the Plan View option from the drop-down 
list to display the top view of the model; the view will be displayed in the Plan View dockable 
window, as shown in Figure 2-25. In the Section View and Plan View window, a triangular marker 
will be displayed on invoking the Walk tool. This marker will represent the camera location and 
it will move in the window as you walk in the Scene View. You can also move the marker in the 
window by dragging it, the camera location will change accordingly in the Scene View.

Figure 2-24  The front view of the model in the Section View window

Figure 2-25  The top view of the model in the Plan View window
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TUTORIALS
General instructions for downloading tutorial files:

1. Download the c02_nws_2021_tut zip file from https://www.cadcim.com. The path of the file
     is as follows: Textbooks > Civil/GIS > Navisworks > Exploring Autodesk Navisworks 2021.

2.  Now, save and extract the downloaded folder at the following location:
     C:\ nws_2021

Note
The default unit system used in the tutorials is metric. To change the units to imperial, select the 
required units from Options Editor > Interface > Display Units.

Tutorial 1 				            Navigating Inside the Model                
                                            

In this tutorial, you will open the c02_navisworks_2021_tutorial.nwf file and move around the 
model using the Walk, Collision, Gravity, Third Person, and other navigation tools. 		
		        						            (Expected time: 45 min)

The following steps are required to complete this tutorial:

a.	 Start the Navisworks Manage session.
b.	 Open the c02_navisworks_2021_tutorial.nwf file.
c.	 Orient the model in the Scene View using the Orbit and Zoom tools.
d.	 Adjust the walk speed.
e.	 Select Avatar and configure its dimension and position for the current viewpoint.
f.	 Move around in the model.
g.	 Move to the other floors of the building.
h.	 Save the project.

Starting Autodesk Navisworks 2021
1.	 Start Navisworks Manage by choosing Start > Autodesk > Navisworks Manage 2021 > 

Manage 2021 from the taskbar; the program is loaded and the user interface screen is dis-
played.

Opening the Existing Model
In this section, you will open the model created in Revit software.

1.	 Choose the Open button from the Quick Access Toolbar; the Open dialog box is displayed.
            

Note
You can also display the Open dialog box by choosing Open > Open from the Application Menu.

2.	 In this dialog box, browse to the following location:
      C:\nws_2021\c02_nws_2021_tut

3.	 Select the Navisworks File Set (*.nwf) option from the Files of type drop-down list.
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4.	 Next, select the c02_navisworks_2021_tutorial.nwf file; the file name is displayed in the File 
name edit box.

5.	 Choose the Open button on the right of the File name edit box; the model is displayed in 
the Scene view, as shown in Figure 2-26.

Figure 2-26  The model opened in Navisworks 

Orienting the Model in the Scene View
In this section, you will adjust the model in the Scene View so that it fits properly in the workspace.

1.	 Invoke the Orbit tool from the Orbit drop-down in the Navigate panel of the Viewpoint 
tab; the Orbit cursor appears on the screen.

2.	 Press and hold the left mouse button, drag the mouse in the left direction, and then release 
it when the model looks similar to the one shown in Figure 2-27.

Figure 2-27  The model after using the Orbit tool

3.	 Next, to enlarge the viewing scale of the model, invoke the Zoom tool from the Zoom 
drop-down in the Navigate panel of the Viewpoint tab; the zoom cursor appears on the 
screen.
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Note
The Orbit and Zoom tools can also be invoked from the Navigation Bar.

4.	 Place the zoom cursor in the model, as shown in Figure 2-28.

Figure 2-28  Placing the Zoom cursor on the model

  

5.	 Press and hold the left mouse button, drag the mouse in the forward direction, and release 
it when the model zooms in, as shown in Figure 2-29.

                              Figure 2-29  The model after using the Zoom tool

Specifying the Navigation Speed
In this section, you will adjust the walk speed while navigating inside a model.

1.	 Choose the Viewpoint tab and then expand the Navigate panel by clicking on the down 
arrow next to it.

2.	 Specify the walking speed 6.00 (19ft 8.22) in the Linear Speed edit box of this panel, as 
shown in Figure 2-30.
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Figure 2-30  Specifying the walk speed in the Navigate panel

Note
You can also specify the walk speed value in the Linear Speed edit box of the Edit Current 
Viewpoint dialog box.

Selecting Avatars and Configuring its Parameters
In this section, you will select avatar and configure its parameters.

1.	 Choose the Edit Current Viewpoint button from the Save, Load & Playback panel in the 
Viewpoint tab; the Edit Viewpoint-Current View dialog box is displayed.

2.	 Choose the Settings button in the Collision area; the Collision dialog box is displayed, as 
shown in Figure 2-31.

Figure 2-31  The Collision dialog box

3.	 In the Collision dialog box, select the Enable check box in the Third Person area. Ensure 
that the Office Female option is selected in the Avatar drop-down list. 

4.	 Make sure that 0.00 degree is specified in the Angle edit box.



2-20 				                   	          Exploring Autodesk Navisworks 2021
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Note that on specifying 0.00 degree value in the Angle edit box, the camera will be placed 
directly behind the avatar.

5.	 In the Third Person area, specify 6.00 (19 ft 8.16) in the Distance edit box.

6.	 In the Viewer area, enter 0.50 (1ft 7.68) in the Radius edit box. 

7.	 Enter 1.60 (5 ft 3.00) in the Height edit box.

8.   Enter 0.15 (0 ft 6.00) in the Eye Offset edit box.

The Eye Offset value specifies the location of camera with respect to the top of the avatar.

9. 	 Next, choose the OK button; the Collision dialog box closes. Again choose OK to close the 
Edit Viewpoint-Current View dialog box. 

10. 	Choose the Walk tool from the Walk/Fly drop-down in the Navigate panel of the Viewpoint 
tab; the Walk tool appears on the screen.

11. Press the left mouse button and click in the Scene View. Now, you can view the avatar, as 
shown in Figure 2-32.

  Figure 2-32  Avatar near the model

Note
Make sure that the Use classic Walk check box is cleared to disable the classic walk tool icon. This 
check box is available in Options Editor > Interface > Navigation Bar. Also, if the avatar is 
displayed near the roof of the South block then drag it and place it near the North block.

12.	 Select the Gravity check box from the Realism drop-down in the Navigate panel of the 
Viewpoint tab.

13.	 Next, press and hold the left mouse button, drag the cursor in the forward direction, and 
then release it when the avatar is placed on the ground, as shown in Figure 2-33. Here, 
avatar faces the North block.
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Note
The position of avatar is not fixed, you can navigate in and around the model as per your choice.

Figure 2-33  Avatar standing on the ground

Moving Around in the Model
In this section, you will walk around the model. Use the following steps to move around the model.  

1.	 Press and hold the left mouse button, drag the mouse in the right direction until the arrow 
appears, refer to Figure 2-34.

Figure 2-34  The cursor displayed in the model

2.	 Drag the cursor in  the left direction and release it when the avatar faces the South block, 
as shown in Figure 2-35.
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Figure 2-35  The avatar facing the south block

3.	 Drag the avatar in the forward direction and place it near the model, refer to Figure 2-36.

Figure 2-36  Avatar moving around inside the model

4.	 Drag the avatar in the left direction and place it near the fourth door from left in the model, 
refer to Figure 2-37.
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Figure 2-37  Avatar moving in the left direction

5.	 Clear the Collision check box from the Realism drop-down in the Navigate panel of the 
Viewpoint tab.

6.	 Drag the avatar in the forward direction and release it when it passes through the doors, 
refer to Figure 2-38.

7.	 Drag avatar in the left direction and release it, refer to Figure 2-39.

Figure 2-38  Avatar passing through the door Figure 2-39  Avatar moved in the left direction
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8.	 Select the Gravity check box from the Realism drop-down in the Navigate panel of the 
Viewpoint tab.

9.	 Move the avatar toward the stairs, as shown in Figure 2-40.

10.  Drag the avatar upward to climb up the stairs, as shown in Figure 2-41.

Figure 2-40  Avatar standing 
near the stairs

Figure 2-41  Avatar walking up the stairs

11.	 Drag the avatar to move up the stairs and place the avatar near the balcony door, as shown 
in Figure 2-42.

Figure 2-42  Avatar standing near the balcony

12.  Clear the Collision check box from the Realism drop-down in the Navigate panel of the 
Viewpoint tab.
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13.  Next, drag the avatar to pass through the door and place it in the balcony area, as shown 
in Figure 2-43.

Figure 2-43  Avatar standing in the 
balcony

Navigating to the Other Levels of the Building
In this section, you will change the levels in the building using Section View.

1.     Invoke the Section View window from the Reference Views drop-down list in the Navigation 
Aids panel of the View tab. The Section View of the building is displayed, as shown in 
Figure 2-44.

Figure 2-44  The section view of the building in the Section View window

2. 	 In the Section View window, drag the triangular marker in such a way that the avatar moves 
to the roof of the building, as shown in Figure 2-45. Figure 2-46 shows the avatar standing 
on the roof. Next, close the Section View window.



2-26 				                   	          Exploring Autodesk Navisworks 2021
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Notice that as you move the triangular marker in the Section View window, the avatar moves  
to the roof in the Scene View.

Figure 2-45  Moving the triangular marker to the first floor of the building

Figure 2-46  Avatar standing on the roof of the 
building

Saving the Project
In this section, you will save the project.

1.   Choose Save As from the Application Menu; the Save As dialog box is displayed.

2.	 Browse to nws_2021\c02_nws_2021_tut folder and enter c02_navisworks_2021_tut01 in the 
File name edit box. Next, choose the Navisworks File Set (*.nwf) file format from the Save 
as type drop-down list, and then choose the Save button.
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Tutorial 2	              			      Flying Around the Model                                            

In this tutorial, you will open the c02_navisworks_2021_tutorial.nwf file and fly around the 
model using the Fly tool. 					           (Expected time: 20 min)
								             
The following steps are required to complete this tutorial:
	
a.	 Start the Navisworks Manage session.
b.	 Open the c02_navisworks_2021_tutorial file.
c.	 Adjust the model in window using the Orbit and Zoom tools.
d.	 Fly around the model.
e.	 Save the project.

Starting Autodesk Navisworks 2021
1.	 Start Navisworks Manage by choosing Start > All Programs > Autodesk > Navisworks 

Manage 2021 > Manage 2021 from the taskbar. The program is loaded and the user interface 
screen is displayed.

Opening the Existing File
In this section, you will open a file which is created in Revit.

1.	 Choose the Open button from the Quick Access Toolbar. Alternatively, choose Open > Open 
from the Application Menu; the Open file dialog box is displayed.

2.	 In this dialog box, browse to the following location:
	 C:\nws_2021\c02_nws_2021_tut

3.	 Select the Navisworks File Set (*.nwf) file from the Files of type drop-down list.

4. 	 Next, select the c02_navisworks_2021_tutorial.nwf  file; the file name is displayed in the File 
name edit box.

5.	 Choose the Open button on the right of the File name edit box; the model is displayed in 
the Scene View, as shown in Figure 2-47.

Orienting the Model in the Scene View
In this section, you will adjust the model in the Scene View so that it fits into the Navisworks 
Scene View.

1.	 Invoke the Orbit tool from the Orbit drop-down in the Navigate panel of the Viewpoint 
tab; the Orbit tool cursor appears on the screen.

2.  Place the cursor at the corner of the model, as shown in Figure 2-48.
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     Figure 2-47  The model displayed in the Scene View

Figure 2-48  Placing the cursor on the model

3.	 Press and hold the left mouse button, drag the mouse in the downward direction, and then 
release it when the model is rotated, as shown in Figure 2-49.

4.	 Now drag the model in the left direction and release it when the model looks like, as shown 
in Figure 2-50.
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.

                Figure 2-49  Model after rotating

 Figure 2-50  The model after using the Orbit tool

5.	 Invoke the Zoom tool from the Zoom drop-down in the Navigate panel of the Viewpoint 
tab; the Zoom tool cursor appears on the screen.

6.	 Press and hold the left mouse button, drag the mouse in the forward direction, and then 
release it when the model is zoomed, as shown in Figure 2-51.

 Figure 2-51  The model after using the Zoom tool
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Flying Around the Model
In this section, you will fly around the model using the Fly tool.

1.	 Invoke the Fly tool from the Walk/Fly drop-down list in the Navigate panel of the Viewpoint 
tab; the flight cursor appears on your screen.

2.	 Hold the left mouse button and drag the mouse in the right direction to fly around the 
model. Figure 2-52 shows a view in the fly mode.

Note
Use the Pan, Orbit, and Zoom tools while flying around the model to adjust the model in such a 
way that you can clearly view the model and it becomes easier to fly around the model.

   Figure 2-52  Flying around the corner of the School building

Saving the Project
In this section, you will save the project.

1.   Choose the Save As from the Application Menu; the Save As dialog box is displayed.

2.	 Browse to nws_2021\c02_nws_2021_tut folder and enter c02_navisworks_2021_tut02 in the 
File name edit box. Next, choose the Navisworks File Set (*.nwf) file format from the Save 
as type drop-down list, and then choose the Save button.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The __________ tool is used to zoom a specified area.

2.	 You can link the position of Navigation Bar with the __________ .
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3.	 The __________ tool is used to rotate the model freely around the pivot point in any direction.

4.	 The Edit Viewpoint - Current View dialog box can be displayed by choosing the __________ 
button.

5.	 The Section View can be displayed by selecting an option from the __________ drop-down 
list.

6.	 The docking position of the Navigation Bar cannot be changed. (T/F)

7.	 The Orbit tool is used to move the given model in the Scene View. (T/F)

8.	 The Look At tool is used to look around the model. (T/F)

9.	 In Navisworks, the walk speed cannot be changed while navigating inside a model. (T/F)

10.	 In Navisworks, the Gravity option can be used while flying around a model. (T/F)

Review Questions
Answer the following questions:

1.   Which of the following options is used to pass the avatar through those objects that are too 
low to walk under?

             a) Gravity 		  b) Crouch
             c) Collision                    d) Fly

2.	 Which of the following options is used for invoking the third person view?
	
             a) Camera		   b) Orbit
             c) Avatar                          d) Zoom

3.	 Which of the following tools is used to change the viewing scale of the model?

             a) Orbit 		  b) Pan
             c) Fly                              d) Zoom

4.	 Which of the following options is used to display the absolute X, Y, Z position of the camera?

             a) XYZ Axes 		  b) Grid Location
             c) Position Readout       d) Section View

5.	 You can specify the radius of an avatar by entering values in the Eye Offset boxes. (T/F)
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6.	 Clearing the Collision check box will enable the avatar to pass through the doors and 
columns. (T/F)

7.	 You cannot change the height of the avatar. (T/F)

8.	 Section View is used to display the top view of a model. (T/F)

9.	 In Navisworks, the Walk and Fly tools can be used simultaneously. (T/F) 

10.	 The Pan tool is used to rotate a model. (T/F)    

EXERCISE
 Exercise 1                 Navigating Inside the Residence Building
Download and open the c02_navisworks_2021_ex1.nwf file from https://www.cadcim.com. Navigate 
inside the Residence Building model, shown in Figure 2-53, by using various navigation tools. 	
			    			    	                     
								               (Expected time: 30 min)

The steps required to complete this exercise are given next:

1.	 Open the c02_navisworks_2021_ex1 file.
2.	 Orient the model using the Orbit and Zoom tool.
3.	 Adjust the walking speed.
4.	 Select avatar and configure its dimension and position for the current viewpoint.
5.	 Navigate inside the model and on the other floors of the building.
6.	 Save the file with the name c02_navisworks_2021_ex01.

 Figure 2-53  The Residence Building

Answers to Self-Evaluation Test
1. Zoom Window, 2. ViewCube, 3. Free Orbit, 4. Edit Current Viewpoint, 5. Reference Views, 
6. F, 7. F, 8. F, 9. F, 10. F


